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A
Compilando o NCL-Inspector a partir do cédigo fonte

Até o momento da escrita desta dissertacao nenhuma versao estavel do NCL
Inspector foi liberada. Porém uma versao usavel pode ser baixada diretamente
da linha principal de desenvolvimento. A obtencao do arquivo executavel
poderé ser feita através da compilacao deste codigo fonte. As informagoes aqui
demonstradas tanto servem para sistemas operacionais Windows quanto para

Unix.

Para compilar o cédigo fonte do NCL-Inspector, sao necessarios:

1. Java SE Development Kit 6 (JDK 6). Disponivel em http: //java.sun.com.
2. Apache Maven 2. Obtido em http://maven.apache.org.

3. Cliente SVN de linha de comando (pode ser outro equivalente, como
o Tortoise, porém serd demonstrado aqui usando apenas linha de co-

mando). Disponivel em http://subversion.tigris.org.

4. Conexao com a internet disponivel.

O NCL-Inspector depende do componente NCL-Parser, que foi desenvolvido
em conjunto por mim e outro aluno de mestrado (Hildebrando Trannin), que
também nao possui uma versao estavel. Portanto, antes de compilar o codigo do
NCL-Inspector, precisaremos fazer o mesmo para o NCL-Parser. Crie um dire-
torio para armazenar as copias de trabalho do codigo fonte do NCL-Inspector
e do NCL-Parser. Iremos chamar essa pasta de nclinspector-workspace. Na
linha de comando, entre dentro da pasta criada e chame o comando (lembrando
que o cliente SVN de linha de comando devera estar declarado na variavel de

ambiente PATH para esse comando funcionar):

svn checkout http://ncl-parser.googlecode.com/svn/trunk/ncl-parser
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Apo6s o término da execucao deste comando, o préoximo passo é compilar
o NCL-Parser utilizando a ferramenta Maven 2. A versao desta ferramenta
que utilizamos foi a 2.2.1. Para instalar o Maven, basta ir até a secao de
downloads do site, fazer o download. Ao término descompacte o arquivo em
um determinado diretoério. Inclua a pasta bin que vem junto com o Maven
na variavel de ambiente PATH, para que vocé possa executar o comando
de qualquer local do sistema. Tendo feito isto, no console, basta entrar na
pasta do NCL-Parser onde estd o arquivo pom.xml (devera estar na pasta

nclinspector-workspace/ncl-parser) e digitar o comando:

mvn install

Este comando ir& baixar todas as bibliotecas e dependéncias necessarias para
a compilacao do codigo fonte e ird executar a compilacao do NCL-Parser. Tenha
paciéncia pois o comando leva um certo tempo para realizar a compilacao. Ao
terminar, execute o comando cd .. e deixe a pasta onde estd o NCL-Parser,
voltando pra raiz das copias de trabalho (nclinspector-workspace). Entao

baixe o coédigo fonte do NCL-Inspector utilizando o seguinte comando:

svn checkout http://ncl-inspector.googlecode.com/svn/trunk/nclinspector

Analogamente & compilagao do NCL-Parser, para compilar o NCL-Inspector
entre na pasta nclinspector (que devera estar o arquivo pom.xml e execute
o comando mvn install. Ao término deste comando, a versao de linha de

comando do NCL-Inspector estard dentro do arquivo zipado:
nclinspector-console-<Verséo>.zip

localizado na pasta:

nclinspector/nclinspector-console/target

Dentro deste zip, existe uma pasta bin. Nesta pasta, possuem dois scripts
para iniciar a execucao do NCL-Inspector. Para executar, os seguintes argu-

mentos deverao ser passados:

ncl-inspector-console <configFile> <inspectedFile> [rulelib path]
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Os argumentos entre <> sao obrigatorios e os entre [] sao opcionais.
O primeiro argumento serve para especificar o arquivo de configuragao do
NCL-Inspector que informa ao programa quais regras de verificacao serao
executadas. O NCL-Inspector vem com um arquivo com todas as regras
disponibilizadas por ele, na pasta conf. Este arquivo podera ser usado caso nao
deseje personalizar as regras que serao executadas. Se desejar uma execucao
de apenas algumas regras, outro arquivo pode ser criado tomando este como

modelo.

O segundo argumento deve ser o arquivo que serd inspecionado pelo NCL-
Inspector. O terceiro é opcional e é recomendado deixar em branco, a nao ser
que deseje especificar outra pasta que contenha implementacoes de regras de

inspecao.
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B
Preparando o ambiente de desenvolvimento de novas re-
gras

Antes de preparar o ambiente de desenvolvimento de novas regras, é neces-
sario que todos as operacoes descritas no Apéndice A tenham sido realizadas

COI1 Sucesso.

B.1
Desenvolvendo novas regras

Para desenvolver novas regras para o NCL-Inspector usando XSL é neces-
sario apenas um editor de texto. Caso seja necesséario o desenvolvimento em
Java, também sera necessario o compilador da linguagem e o arquivo jar cor-

respondente ao mecanismo de regras.

Apesar de ser perfeitamente possivel a criacao de regras utilizando apenas as
ferramentas mencionadas no paragrafo anterior, para criar o conjunto de regras
padrao do NCL-Inspector, utilizamos um ambiente um pouco mais sofisticado.
Usar um ambiente mais sofisticado nos d4 um custo maior de configuracao,
porém fornece uma maior facilidade na criacao das regras. Escolher qual
ambiente utilizar é uma decisao muito subjetiva. Se o desenvolvedor necessita
escrever muitas regras, talvez seja interessante gastar um tempo configurando
um ambiente mais sofisticado. Caso contrario, se apenas algumas poucas regras
forem escritas, talvez o custo de configurar um ambiente mais sofisticado nao

valha a pena.

Para configurar o ambiente de criacao de regras, necessitaremos dos seguintes

componentes:

1. Eclipse IDE for Java Developers 3.5 (Galileo) SRI.

2. m2eclipse (plugin do Maven para o Eclipse)
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Va até o site http://www.eclipse.org/downloads/ e baixe a versao do Eclipse
de acordo com a figura B.1. Descompacte o arquivo, isto resultara na criagao de
uma pasta chamada eclipse. Dentro desta pasta, execute a aplicacao através

do arquivo eclipse.exe se o seu sistema for Windows ou eclipse se o seu
sistema for GNU/Linux.

Eclipse Packages Projects Development Builds

Galileo Packages (based on Eclipse 35 5R1) - Compare Packages

Eclipse IDE for Java EE Developers (188 MB)
Tools for Java developers creating Java EE and Web applicaticns, including a Java IDE,
JEE tools for Java EE, JPA, JSF, Mylyn and others. More...
L———1 Downloads: 1,456 026

®

The essential tools for any Java developer, including a Java IDE, a CWVS client, XML Editor
and Mylyn. More._ ..
Downloads: 716,656

" ; Eclipse IDE for Java Developers (92 MB)

Eclipse for PHP Developers (138 MB)
a Tools for PHP developers creating Web applications, including PHP Development Tools
m (PLOT), Web Tools Platform, Mylyn and others. More...
Downloads: 335,992
—..  Eclipse IDE for C/C++ Developers (79 MB)

([ ) An IDE for C/C++ developers with Mylyn integration. More...
{\d Downloads: 352,438

Figura B.1: Pagina de download do Eclipse

Ao iniciar, o Eclipse ird pedir para selecionar uma pasta para armazenar seu

workspace. Selecione a pasta que desejar e clique em OK.

O proéximo passo, serd a instalacao do plugin do Eclipse para integracao
com o Maven. Para prosseguir, clique na op¢ao de menu “Help” > “Install
new software...”. Ir4 aparecer a janela mostrada na figura B.2 e entao cli-
que no botao “Add”. Na nova janela digite no campo “Location” a URL
http://m2eclipse.sonatype.org/update/ e clique em “OK”, como mostrado
na figura B.3.

Selecione todos os plugins, exceto o “Maven SCM handler for Subclipse” e
“Maven Integration for AJDT”, como mostra a figura B.4. Caso sua instalagao
do Eclipse possua o Subclipse ou o ApectJ Development Tooling (AJDT),
vocé podera deixar marcada as respectivas opcoes. Terminada a selecao, clique
en “Next”. Prossiga pelo assistente e aceite os termos da licenga e clique

em “Finish”. E possivel que o Eclipse apresente uma mensagem pedindo a
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[ a O Install —— @ @ @
Available Software ]—P
) ) ) |
select a sit terthe location of a site. _—
ele a site or enterthe location of a site a I
Wiork with: | type or select a site | w | | Add.., |

Find more software by working with the 'Available Software Sites' preferences,

Wersion

) There s no site selected.

Details

You may select a site inthe combo box at the top. You may also type or paste a site name into the cambao }—3

&1 Show only the |atest versions of available software | | Hide itemns that are already installed
[/ Group items by category What isjalreadg installed?

|«| Contact all update sites during install to find required software

@ i -

Figura B.2: Janela de instalacao de plugins do Eclipse

i e D Add Site —_——— @ @
Name: | | | Local... |
Laocation: [http:HmZeclipse.sunatype.org;’update,‘ I | Archive. .. |

@ | OK | | Cancel |

Figura B.3: Adicionando o site de instalagao do Plugin do Maven.

confirmacao para instalar um contetido nao-assinado. Se isto ocorrer, permita

que o contetido seja instalado.

Prossiga criando um novo projeto através da opcao de menu “File” > “New”
> “Other”, ou pressionando a tecla Ctrl+N. Como no projeto NCL-Inspector,
também usaremos o Maven para criar e gerenciar o projeto. Por isso, devemos
criar um novo “Maven Project”, como mostrado na figura B.5 e clique em
“Next”.

No passo seguinte, marque a opgao “Create a simple project (skip archetype
selection)” e clique novamente em “Next”. A seguir aparecera uma tela com
diversos campos a serem preenchidos, a descri¢ao do significado de cada campo

esta a seguir.


DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-Rio - Certificacdo Digital N° 0721326/CA

Apéndice B. Preparando o ambiente de desenvolvimento de novas regras

MName

vy NI Maven Integration

=[] 000 Maven Optional Compaonents
(4] @ Mawven Central repository index (Cptional)
(i '-é?: Maven Doxia Editors (Optional) .
M %?: Mawen issue tracking configurator for Mylyn (Optional)
=i @ Mawen issue tracking configurator for Mylyn 3.x (Optional) i
| '-5;_5‘- Maven SCM handler for Subclipse (Optional)
W @ Maven SCM handler for Team/CVS (Optional)
= Le?: Mawen SCM Integration {Optional)

= [=] 000 Maven Project Configurators
|| @} Mawven Integration for A|DT (Optional)
il '-@ Mawen Integration far WTP tDpticn;aIJ

| Wersion

009.7.200902090947
0.9.8.200905041414

0.9.5.20080717-1821

0.9.8.200905041414

- 0.5.8.200905041414
: 0.9.5.200905041414

0.9.8.200905041414

0.9.5.200905041414
0.9.8.200905041414

ET¢

b P

95

Figura B.4: Selecao dos plugins da integragao com o Maven que serao instala-

dos.

=2 () New

Select a wizard

Create a Maven Project

Wizards:
[

I = General

b = Apache Doxia

b = ovs

P = Java

= = Maven
T..:l" Checkout Maven Projects from 5CM
M4 Maven Module
ﬁ Maven POM file

l'E-f Maven Project

[ (= Tasks

P= xmL
P (= Examples

&

@ TN U

Eini|sh | | Cancel

Figura B.5: Criando um novo projeto Maven
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2 C’ New Maven Project ———— @ (o:?l @
New Maven project =
Configure project ML‘
Artifact

Group |d: ibr.pucrio.serg.nclinspectorexample

Artifact Id: | nclinspectorexample

Version: iD.U.l-SNAPSHGT
Packaging: ijar | v |
MName; iExemplos para o NCL-Inspector

Description: ﬁExempIos de como montar um ambiente para estender a biblioteca T|
|c|e regras do MCL-Inspector. |

Parent Project

Group |d: l

Artifactld: |

Mersion: | IBrowse...

¥ Advanced

) | <Back || Next = || finish | | Cancel |

Figura B.6: Tela de configuracao do projeto Maven

Groupld é um identificador de uma colecao de modulos relacionados. E
comumente uma hierarquia que se inicia com a organizagao que produziu
esses modulos. Muito parecido (ou idéntico) ao sistemas de pacotes de

Java.
ArtifactId é um identificador inico para os mo6dulos de um grupo.

Version é usado para identificar uma release ou nimero do build de um

projeto.

Packaging ¢é o formato do artefato que serd gerado. Nosso caso, somente faz

sentido ser formato jar.
Name é um nome mais amigével para o projeto.

Description como o préprio nome ja diz, é uma breve descricao do projeto.

Preencha os campos desta tela de acordo com a figura B.6. Com o Maven é
possivel estruturar os moédulos de forma hierarquica, porém este projeto possui
apenas um modulo, portanto, ignore o “Parent Project”. Clique em “Finish” e

finalize a criacao do projeto.


DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-RIo - Certificacdo Digital N° 0721326/CA

0 N O O bW

QO N O b W N

Apéndice B. Preparando o ambiente de desenvolvimento de novas regras 97

Dentro do projeto criado é possivel ver um arquivo chamado pom.xml
(Project Object Model) com o contetido apresentado na listagem B.1. Esse

arquivo fornece subsidios para o Maven gerenciar o projeto.

<project xmlns="http://maven.apache.org/POM/4.0.0" xmlns:xsi="
http://www.w3.0org/2001/XMLSchema-instance"

xsi:schemalocation="http://maven.apache.org/POM/4.0.0 http://
maven .apache.org/maven-v4_0_0.xsd">

<modelVersion>4.0.0</modelVersion>

<groupId>br.pucrio.serg.nclinspectorexamples</groupIld>

<artifactId>nclinspectorexamples</artifactId>

<name >Exemplos para o NCL-Inspector.</name>

<version>0.0.1-SNAPSHOT</version>

<description>Exemplos de como montar um ambiente para
estender a biblioteca de regras do NCL-Inspector.</
description>

</project>

Listagem B.1: pom.xml gerado.

Para escrever regras em Java, é necessario incluir o componente nclinspector-
engine como dependéncia do projeto. Isso é feito adicionando o c6digo mos-
trado na listagem B.2 apds o elemento <description> do arquivo pom.xml
(linha 8 da listagem B.1).

Note que o nimero da versao, especificado pelo elemento <version> deve
ser correspondente ao niimero de versao do codigo fonte compilado no apéndice
A. Para descrobrir qual a versao que foi compilada, veja o arquivo pom.xml na

pasta que contém os fontes do NCL-Inspector.

<dependencies>
<dependency >
<groupId>br.pucrio.inf.serg.nclinspector</groupld>
<artifactId>nclinspector-engine</artifactId>
<version>0.0.1-SNAPSHOT</version>
<scope>provided</scope>
</dependency >

</dependencies>

Listagem B.2: Trecho de cddigo para adicionar dependéncia do nclinspector-

engine.

B.2
Testando as regras
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B.3
Fazendo a implantacdo de novas regras

Para fazer a implantacao basta rodar o Maven a partir do Eclipse utilizando o
goal package, como mostra a figura B.7. Ao término, um arquivo jar sera criado
dentro do diretorio target. Copie esse jar para o diretoério rulelib dentro da

distribuicao binaria da versao de linha de comando do NCL-Inspector.

) () Java-Eclipse <> ————————— ® @ ®

File  Edit: Source Refactor MNavigate Search Project Run Window Help
| tov v Ov Qv | & # OV e e g B Gy = [ghava

tg Hieran:hy“ = ﬁ.|

= 0| TeskList 52 =
Ovifew | % B & | 4@ ~

Fir [ v a1 b Activate.

2% Uncategorized |

-

= fil,éi nclinspectorexamples
28 src/mainfja beew) 2
(8 srcfmainfre SHE

[ sreftestfjav, Open in New Window

|28 sreftestires Open Type Hierarchy F4
B |RE System Show In Shift+AlL+W >
s, Maven Dep
E=src

== target

P = maven-

= Copy Cti+C
i Copy Qualified Name

4 = = =

[} Paste Cirl+V B= utiine 52 . v =8
¥ Delete Delete

éj nelinspe An outline is not available:

| porn.xm " I
Build Path >
Source Shift+AIt+5 >
Refactar Shift+AIt4+T >

g2y Import...
7% Export..

£ Refresh F5

Close Project [ 1 )ava Applet Shift-+Alt+X A

Assign Working Sets 71 2 Java Application Shift+Alt+X] ————
A . =
mZ 3 Maven assemblyassembly =
m2 4 Maven build Shift+AlE+HK M 7@:] = Fiv

m2 5 Maven build...

Liebug As
Validate
m2 B Maven clean L
m2 Maven >
>

w

mi T Maven generate-sources
Team

Campare With 3 m2 8 Maveninstall e

: ] Restare from Lacal History. kozshaven packEBE ] )

| o nelinspe m2 Maven source:jar ‘

Properties AILHEREr |y Maven test

Figura B.7: Gerando um pacote jar para implantagao das regras.

Apos isso, é necessario criar o arquivo de configuracao do NCL-Inspector.
Se ja tiver sido criado, basta adicionar as entradas das regras que deverao ser

utilizadas, como mostrado na secao 4.2.4, pagina 40.
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Questionario Pré-Avaliacao do NCL-Inspector

Qual é o seu nivel de conhecimento nas seguintes tecnologias? E ha
quanto tempo as utiliza?

Tecnologia Nivel de conhecimento Tempo de utilizacao
Java Especialista () () () () () Novato ___ anos e ___ meses
XML Especialista ( ) () () () () Novato ___ anos e ___ meses
XSL Especialista () () () () () Novato ___ anos e ___ meses
NCL Especialista () () () () () Novato ___ anos e ___ meses
Eclipse Especialista ( ) () () () () Novato ___ anos e ___ meses

Quantas aplicacées vocé ja desenvolveu utilizando as seguintes tecno-
logias?

Tecnologia Numero de aplicagoes

Java ()204+ ()15-19 ()10-14 ()6-10 ()1-5 ()0
XML ()20+ ()15-19 ()10-14 ()6-10 ()1-5 ()0
XSL ()204+ ()15-19 ()10-14 ()6-10 ()15 ()0
NCL ()20+ ()15-19 ()10-14 ()6-10 ()1-5 ()0
Eclipse ()20+ ()15-19 ()10-14 ()6-10 ()1-5 ()0
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Como vocé adquiriu seu conhecimento em NCL? (Marque todas as
aplicaveis)

Item

Lendo a norma da ABNT
Lendo o livro de NCL
Lendo o tutorial de NCL disponivel em

www.ncl.org.br
Estudando as aplica¢oes do Clube NCL

Outras fontes. Quais?

Percentual lido/estudado de cada
item

100%()()()()()0%
100%()()()()()0%
100%()()()()()0%

100%()()()()()0%
100%()()()()()0%

Caso ja tenha elaborado alguma aplicacio NCL, que ferramentas cos-
tuma utilizar? (Marque todas as aplicaveis)

(

(
(
(
(
(

)
)
)
)
)
)

Composer
NCL-Eclipse

Editores de texto avangados (e.g. Text-Mate, Emacs, vi)

Editores de texto basicos (e.g. Bloco de notas)

Nunca elaborei uma aplicagao NCL

Outros. Quais?

Caso ja tenha elaborado alguma aplicacio em Java, que ferramentas
costuma utilizar pra realizar os testes? (Marque todas as opcdes apli-
caveis)

(
(
(
(

)
)
)
)

JUnit
TestNG

Nao utilizo as ferramentas ou realizo testes

Outros. Quais?
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Caso ja tenha elaborado alguma aplicacio em Java, indique quais
técnicas vocé costuma utilizar na construcdo desses programas (Marque
todas as opcdes aplicaveis)

Técnica Uso

Classes ou métodos abstratos Frequentemente( ) As vezes () Nunca ()
Nao conhego( )

Generics (Templates) Frequentemente( ) As vezes () Nunca ()
Nao conhego( )

Reflex@o e Introspecgao Frequentemente( ) As vezes () Nunca ()

Nao conhego( )

Classes Internas (Inner Classes) Frequentemente( ) As vezes () Nunca ()
Nao conhe¢o( )

Uso de Interfaces Frequentemente( ) As vezes () Nunca ( )
Nao conheco( )
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Exemplo da Descricao do Problema usado no Experimento

D.1
Descricao

A norma NCL indica que elementos <media> que possuem o valor do atributo
type igual a application/x-ginga-NCL nao podem ter definidos os atributos

instance e refer. Além disso, o elemento <media> deste tipo, nao pode definir
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elementos filhos, isto é, aninhados.

D.2
Exemplos de elementos media que violam essa restricao

<media id="mirrorProgl" type="application/x-ginga-NCL" src="
progl.ncl" descriptor="descPDA" refer="xpto" instance="

instSame" />

Listagem D.1: Exemplo 1

<media id="mirrorProgl" type="application/x-ginga-NCL" src="

progl.ncl" descriptor="descPDA">

<area id="al" begin="1s" end="3s" />
<area id="a2" begin="6s" end="9s" />
</media>
Listagem D.2: Exemplo 2
<media id="mirrorProgl" type="application/x-ginga-NCL" src="

progl.ncl" descriptor="descPDA" refer="xpto" instance="

instSame">

<area id="al" begin="1s" end="3s" />
<area id="a2" begin="6s" end="9s" />
</media>

Listagem D.3: Exemplo 3
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E
Ficha de Apoio a Observacao de Uso

Qual a tecnologia escolhida para elaborar a regra?

() Java () XSL

Quais davidas surgiram? Como foram esclarecidas?

Sober a conclusao do teste

Conseguiu com apenas uma leitura

Conseguiu depois de mais de uma leitura

Detalhes:



DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-RIo - Certificacdo Digital N° 0721326/CA

Apéndice E. Ficha de Apoio a Observacdo de Uso

Observacoes gerais

104



DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-RIo - Certificacdo Digital N° 0721326/CA

F
Roteiro da Entrevista Pés-Avaliacao do NCL-Inspector

F.1
Por que optou por utilizar a tecnologia escolhida (XSL ou Java)?

F.2
O que achou do mecanismo de regras?

F.2.1
O que achou mais facil?

F.2.2
O que achou mais complicado ou chato?

F.3
O que vocé modificaria no processo de criacdo de regras?

F.4
Compare o esforco de elaboracio de uma regra com o de inspecdo
manual dos programas NCL?

Obs: Se mencionar que “para uma aplicacao grande vale a pena imple-
mentar uma regra” deve ser perguntado: (1) o que vem a ser uma aplicagdo
grande? (2) Tem algum exemplo em mente de uma aplicagao grande? (3) Tem
alguma meétrica para avaliar uma aplicagao grande (no. de elementos, contex-

tos, elos, linhas) 7

F.5
Vocé teria alguma sugestio de carater geral?
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G

Problemas encontrados no XML Schema do NCL

# | Descricao Como foi contornada

1 | A informagao dada pelo XML | Foi adotado o que foi apresentado
Schema é que o atributo id do ele- | na norma, ou seja, o atributo id
mento <ncl> é requerido. No en- | do elemento <ncl> é opcional.
tanto, na norma é informado que
este atributo é opcional.

2 | No XML Schema o elemento | Foi adotado determinado pela
<regionBase> possui um atributo | norma, ou seja, para o elemento
type. Na norma, este atributo nao | <regionBase> o atributo type nao
existe. existe.

3 | No arquivo | Foi corrigido este problema e ado-
NCL30KeyNavigation.xsd existe | tado o nome do atributo que
um aparente erro de digita- | foi entendido como correto (i.e.
cao dos atributos focusSrc | focusSrc e focusSelSrc).

e focusSelSrc. Esses foram
digitados como focusScr e
focusSelScr.

4 | Em NCL30CausalConnectorFun. . .
existe uma quebra de linha na
URL dos moédulos importados que
nao esta permitindo que o Schema
seja validado corretamente.

5 | Aparentemente o focusIndex | No parser implementado por mim,

do elemento <descriptor>, de
acordo com o tutorial, deveria per-
mitir uma xs:string como valor,
mas no schema estd permitindo
apenas xs:positivelnteger.
Isto também se aplica aos atri-
butos moveRight, moveLeft,
moveUp, moveDown do elemento
<descriptor>.

considerei o tipo do valor de
focusIndex como xs:string.

14/04,/2009

Tabela G.1: Problemas encontrados no XML Schema da norma com data de
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H
Catalogo de problemas de cédigo NCL

Durante a execucao desse trabalho, foi necessario ter um conhecimento
maior dos problemas de c6digo que ocorrem em programas NCL. A partir
de uma andlise detalhada da Norma ABNT da NCL e do livrto de NCL
(Soares e Barbosa 2009), foi feito um levantamento de quase uma centena
de problemas de cédigo NCL. Todos esses problemas aqui descritos nao sao
detectados por uma validacao baseada no XML Schema. Os problemas estao

divididos de acordo com os mo6dulos da linguagem NCL.

H.1
Médulo Structure Functionality

Neste modulo, nenhum problema de codigo foi encontrado que nao pudesse

ser detectado a partir de uma validacao baseada no XML Schema.

H.2
Moédulo Layout functionality

1. O wvalor do atributo device de <regionBase> deve ser

"systemScreen(i)" ou "systemAudio(i)".

Referéncia: p.34§4

2. O atributo region de <regionBase> deve ser formado de acordo com a

norma (vide referéncia).

Referéncia: p.3486

3. Os atributos left, right, top, bottom, height, width e zIndex de uma

<region> devem estar formados de acordo com a norma (vide referéncia).
Referéncia: p.3489
4. Quando uma <region> nao especifica atributos de tamanho e posiciona-

mento (left, right, height, width, etc), é assumido que essa <region>

terd o mesmo tamanho e posicao da <region> pai. Caso seja uma
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<region> raiz, seu tamanho serd igual a toda area do dispositivo de

apresentacao.
Referéncia: p.35§1
5. Quando uma region especifica simultaneamente os atributos top, bottom
e height ou left, right e width pode ocasionar em inconsisténcias.
Referéncia: p.35§2
Estado: Terminado
6. Uma <region> filha nao pode estar fora de uma area estabelecida pela
<region> pal.
Referéncia: p.35§2,
7. Quando dois elementos <region> sobrepostas, isto ¢ com o mesmo

zIndex, e com a mesma ordem temporal ir4 ocasionar uma <region>

aparecer sobre a outra de forma aleatoéria.
Referéncia: p.3583
8. Caso nao seja especificado um valor do atributo zIndex, para um
elemento <region>, sera atribuido a ele um valor 0 como padrao.

Referéncia: p.3583

H.3
Modulo Components functionality

1. A URI do atributo src de um elemento <media> devem estar bem

formadas de acordo com a tabela (vide referéncia).
Referéncia: p.36 tab.11
2. A referéncias feitas pelo atributo src de um elemento <media> devem
existir. (e.g. Verificar se o arquivo referenciado por src existe)
Referéncia: Nao possui
3. Nao pode haver mais de um elemento <media> com atributo
type="application/x-ginga-settings".
Referéncia: p.36§ultimo
Estado: Terminada
4. As varidveis de ambiente reservadas do elemento <media> do

type="x-ginga-settings" devem estar bem formadas, de acordo

com a tabela. (vide referéncia)"


DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-RIo - Certificacdo Digital N° 0721326/CA

Apéndice H. Catalogo de problemas de cédigo NCL 110

10.

11.

12.

Referéncia: p.37 tab. 12
Nao pode haver mais de um elemento <media> com atributo
type="application/x-ginga-time".
Referéncia: p.40§1
Estado: Terminada
O contetido de <media> type="application/x-ginga-time" deve ser
validado de acordo com o paragrafo da norma (vide referéncias).
Referéncia: p.40§2
O atributo type de <media> deve ser um mimetype valido de acordo com
a tabela (vide referéncias).
Referéncia: p.41 tab.13
O atributo type de um elemento <media> é opcional, mas uma vez que é

usado, o mimetype deve corresponder a extensao do arquivo especificado

no atributo src.
Referéncia: p.41 tab.13
Um elemento <media> com o atributo type="application/x-ginga-NCL"

ou "application/x-NCL-NCL" nao podem ter atributos instance e

refer. Também nao pode ter elementos filhos.
Referéncia: p.41§4
Nao pode haver atributos refer e instance para um elemento

<media> com o type com o valor "application/x-ginga-settings"

e "application/x-ginga-time".
Referéncia: Nao possui
Um elemento <context> nao pode conter como valor do atributo refer
um valor de id de um <context> pai ou ele proprio.
Referéncia: Livro pag. 163
Os elementos <media> com type="application/x-ginga-time",

"application/x-ginga-settings", "application/x-NCL-time",

"application/x-NCL-settings" nao devem possuir o atributo src.

Referéncia: Nao possui
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H.4

Médulo Interfaces Functionality

1.

Um elemento <area> de uma <media definida com atributo
type="application/x-ginga-time" ou "application/x-NCL-time"

deve possuir sempre os atributos begin e end.
Referéncia: p.42§3
Um elemento <area> de uma <media> definida com atributo

type="application/x-ginga-time" ou "application/x-NCL-time"

deve ser sintaticamente bem formado de acordo com UTC.

Referéncia: p.42§4 e 5 (nota 1 e 2)
Um elemento <area> deve possuir os atributos text e position apenas
se o elemento <media> pai for do tipo texto.

Referéncia: Livro pag. 168 e 169
Os atributos begin, end, first, last, position, coords, etc. do ele-
mento <area> devem ser bem formados (vide referéncia).

Referéncia: Livro pag. 168 e 169
Deve haver ao menos um elemento <port> aninhado em cada elemento
<context> e <body>.

Referéncia: Livro pag. 165
O atributo component de um elemento <port> devera referenciar apenas
um id de um elemento <media> ou <context>.

Referéncia: Livro pag. 164
O atributo interface do elemento <port> segue a regra: se o atributo
component for um elemento <media>, o atributo interface devera ser
um identificador de um elemento <area> ou o valor de um atributo
name de uma <property>. Caso o atributo component seja um elemento

<context>, o atributo interface deverd ter um identificador de um

elemento <port>. Porém esse elemento é opcional.

Referéncia: Livro pag. 164
O elemento <property> com o atributo name reservados, devem possuir
seus atributos value validados de acordo com a tabela.

Referéncia: p.45 tab.20
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9.

10.

11.

12.

13.

14.

H.5

O atributo name de um elemento <property> nao deve conter valores

repetidos para um mesmo elemento <media>.

Referéncia: Nao possui

Estado: Terminada
O “group” property usados em conjunto com suas respectivas “single” pro-
perty pode gerar inconsisténcias. Em outras palavras o valor location
nao pode ser usada com left e top, o valor size nao pode ser usada

com width e height e bounds nao pode ser usada com top, left, width

e height para uma mesmo elemento <media>.
Referéncia: p.43§ult.
Mesmo quando o elemento switch seleciona objetos inteiros, é uma boa

préatica identificar esse tipo de selecao explicitamente através de elemento

<switchPort>.
Referéncia: Livro pag. 228
O atributo component do elemento <mapping> aninhado com

<switchPort> deve ter um identificador de um elemento <media>,

<context> ou <switch> internos ao <switch> que o contém.
Referéncia: Nao possui

O atributo interface do elemento <mapping> aninhado com o elemento

<switchPort> deve ter um identificador de um elemento <area>.
Referéncia: Nao possui

O atributo coords do elemento <area> s6 deve estar presente se o

elemento <media> pai for uma midia visual (e.g. video, imagem)

Referéncia: Livro pag. 169

Médulo Presentation Specification Functionality

1.

2.

O <descriptor> de uma <media> do tipo "application/x-ginga-NCL"

ou "application/x-NCL-NCL" nao devem ter o attributo player.
Referéncia: p.4489

Os atributos de <descriptor> devem ser validados de acordo com a

norma (vide referéncias).

Referéncia: (p.4488) (p.46§1)
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3. E possivel redefinir os atributos de uma <region> pelo
<descriptorParam>. Os atributos value desses <descriptorParam>

devem ser validados (vide referéncias).
Referéncia: p.44§10
4. Os <descriptorParam> com o atributo name reservados, devem possuir
seus atributos value validados de acordo com a tabela (vide referéncia).
Referéncia: p.45 tab.20
Estado: Testes pendentes
5. O atributo name de um <descriptorParam> nao deve conter valores
repetidos para um mesmo <descriptor>.
Referéncia: Nao possui
Estado: Terminada
6. O "group'<descriptorParam> usados em conjunto com suas respecti-
vas "single"<descriptorParam> pode gerar inconsisténcias. Em outras
palavras o valor location nao pode ser usada com left e top, o va-
lor size nao pode ser usada com width e height e bounds nao pode

ser usada com top, left, width e height para uma mesmo elemento

<descriptor>.

Referéncia: Nao possui

H.6
Médulo Linking Functionality

1. O atributo xconnector do elemento <link> deve ser bem formado de
acordo com a norma. (e. g. avisar que se um elemento <1ink> referenciar

um xconnector inexistente, esse <link> serd ignorado) (vide referéncia)
Referéncia: p.468§ult.
2. O atributo role do elemento <bind> deve estar definido no xconnector
o qual o elemento <1ink> que o contém faz referéncia.
Referéncia: p.47§ 1 e 2
3. O atributo component de um elemento <bind> deve referenciar apenas
um elemento <media> ou <context>.

Referéncia: Nao possui
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4.

Ut

H.7

O atributo interface do elemento <bind> devera ser validado seguindo
a regra: se o atributo component for um elemento <media>, o atributo
interface devera ser um identificador de um elemento <area> ou o valor
de um atributo name de uma <property>. Caso o atributo component
seja um elemento <context>, o atributo interface deverid ter um

identificador de um elemento <port>. Porém esse elemento é opcional.
Referéncia: Nao possui
Os atributos name de <linkParam> e <bindParam> se referenciam a pa-

rametros definidos no connector referenciado pelo atributo xconnector

do elemento <1ink> que o contém.

Referéncia: p.47§3
Todos o0s <connectorParam> de um <causalConnector> devem ser
utilizados no elemento <link> que o referencia.

Referéncia: Nao possui

Madédulo Connectors Functionality

1.

O atributo role do elemento <simpleCondition> deve ser inico para o

conjunto de roles de um elemento <causalConnector>.
Referéncia: p.49§ ult.

Estado: Faltando testes

. Os atributos eventType e transition do elemento <simpleCondition>

sdo opcionais se o role possui um valor reservado (e.g. onBegin, onEnd,

etc), caso contrario, deverao ser especificados.
Referéncia: p.49§ ult.
O atributo key do elemento <simpleCondition> sé deve existir se o valor

do atributo eventType for igual a "selection" (e.g. onSelection). Vide
tabela 24.

Referéncia: p.50 § 1

. Validar o atributo key do elemento <simpleCondition> para aceitar

apenas os valores validos de acordo com a norma.

Referéncia: p.50 § 1
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10.

11.

12.

O atributo min (que indica cardinalidade) do elemento
<simpleCondition> deve ser validado: deve ser um inteiro maior
que zero e menor ou igual ao valor especificado pelo atributo max. O

atributo min nao aceita valores "unbounded".

Referéncia: p.50 § 2

O atributo max (que indica cardinalidade) do elemento
<simpleCondition> deve ser validado: deve ser maior ou igual ao

atributo min e aceita o valor "unbounded".

Referéncia: p.50 § 2

Caso o elemento <simpleCondition> declarado possua uma cardinali-
dade maior que um (i.e. o atributo min ou max forem maiores do que 1)

devera ser obrigatoriamente especificado o atributo qualifier.

Referéncia: p.50 § 2

O numero de elementos <bind> para um determinado valor de role em
um <link> devera respeitar os valores definidos para os atributos min e

max do elemento <simpleCondition> que define aquele role.

Referéncia: Nao possui

O atributo role do elemento <simpleAction> deve ser tinico para o

conjunto de roles de um elemento <causalConnector>.
Referéncia: p.51 § 2

Estado: Faltando testes

Os atributos eventType e transition do elemento <simpleAction> sao
opcionais se 0 role possui um valor reservado (e.g. onBegin, onEnd, etc),

caso contrario, deverao ser especificados.

Referéncia: p.51 § 3

Se o valor do atributo eventType do elemento <simpleAction> ¢é
"attribution" (e.g. set), o elemento <simpleAction> deve especifi-
car o valor da atribui¢ao através do elemento value. (Vide tabela 26 e

referéncias).

Referéncia: p.51 § 3

O atributo min (que indica cardinalidade) do elemento <simpleAction>
deve ser validado: deve ser um inteiro positivo, maior que zero e menor
que o valor especificado pelo atributo max. O atributo min nao aceita

valores "unbounded".


DBD
PUC-Rio - Certificação Digital Nº 0721326/CA


PUC-RIo - Certificacdo Digital N° 0721326/CA

Apéndice H. Catalogo de problemas de cédigo NCL 116

13.

14.

15.

16.

17.

18.

19.

20.

Referéncia: p.51 § penult.

O atributo max (que indica cardinalidade) do elemento <simpleAction>
deve ser validado: deve ser maior que o atributo min e aceita o valor

"unbounded".
Referéncia: p.51 § penult.
Caso o elemento <simpleAction> declarado possua uma cardinalidade

maior que um (i.e. o atributo min ou max forem maiores do que 1) devera

ser obrigatoriamente especificado o atributo qualifier.
Referéncia: p.51 § penult.
O elemento <simpleAction> s deve possuir os atributos animation e
by caso valor do atributo eventType for "attribution".
Referéncia: p.52 § 1
O atributo role do elemento <attributeAssessment> deve ser tnico
para o conjunto de roles de um elemento <causalConnector>.
Referéncia: p.52 § 5
Estado: Faltando testes
O atributo key de <attributeAssessment> sé deve estar definido se o

valor do atributo eventType for igual a "selection" (e.g. onSelection).
Vide tabela 24.

Referéncia: p.52 § 6

O atributo key do elemento <attributeAssessment> deve ser validado

de acordo com a norma (vide referéncia).

Referéncia: p.52 § 6

Se o valor do atributo eventType de <attributeAssessment> for
"presentation" o valor do attributeType deverd "occurrences",

"repetition" ou "state".

Referéncia: p.52 § 6

Se o valor do atributo eventType de <attributeAssessment> for
"selection" o atributo attributeType pode ser opcional, mas se esti-

ver presente, devera possui os valores "occurrences" ou "state".

Referéncia: p.52 § 6
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21.

22.

23.

24.

H.8

Se o valor do atributo eventType de <attributeAssessment> for
"attribution" o atributo attributeType pode ser opcional, mas se esti-
ver presente, deverd possui os valores: "nodeProperty", "occurrences",

"repetition" ou "state".

Referéncia: p.52 § 6
O atributo name do elemento <connectorParam> deve ser Gnico para o
conjunto de names de um elemento <causalConnector>.

Referéncia: Nao possui

Estado: Faltando testes
Um elemento <causalConnector> nao pode possuir elementos filhos
<simpleAction> e <compoundAction> simuntaneamente.

Referéncia: Nao possui
Um elemento <causalConnector> nao pode possuir elementos filhos
<simpleCondition> e <compoundCondition> simuntaneamente.

Referéncia: Nao possui

Modulo Presentation Control Functionality

1.

O atributo var de um elemento <rule> deve ter o mesmo va-
lor do atributo name de um elemento <property> filho de um
elemento  <media>  type="application/x-ginga-settings" e

"application/x-NCL-settings".

Referéncia: p.54§ 4

. O atributo rule do elemento <bindRule> deve conter um identificador

de um elemento <rule> ou <compositeRule>.

Referéncia: Nao possui

. O atributo constutient de <bindRule> deve conter um identificador de

um elemento <media>, <context> ou <switch> internos ao <switch>

onde esta.

Referéncia: Nao possui

. O elemento <defaultComponent> de um <switch> nao for definido e caso

nenhum elemento <bindRule> definido nesse <descriptorSwitch> seja
avaliado como true, nenhum componente sera selecionado e o formatador

ird tratar como se o componente nao existisse.
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Referéncia: Guia de Operacgoes p.3984

5. O atributo component de um elemento <defaultComponent> deverd
referenciar apenas um id de um elemento <media>, <context> ou

<switch> internos ao <switch> de onde esta.
Referéncia: Nao possui
6. O elemento <defaultDescriptor> de um <descriptorSwitch> nao for
definido e caso nenhum elemento <bindRule> definido nesse <switch>

seja avaliado como true, nenhum componente serd selecionado e o

formatador ird tratar como se 0 componente nao existisse.

Referéncia: Nao possui

H.9
Médulo Timing Functionality

Neste médulo, nenhum problema de codigo foi encontrado que nao pudesse

ser detectado a partir de uma validacao baseada no XML Schema.

H.10
Modulo Reuse Functionality

1. O atributo alias do elemento <importBase> deve ter um valor dnico

em todo o documento.
Referéncia: p.56§ 5

Estado: Faltando testes

2. O valor do atributo alias de <importBase> tem escopo de documento.
Referéncia: p.56§ 5
3. O arquivo do documento NCL referenciado pelo atributo documentURI
do elemento <importBase> deve existir.
Referéncia: Nao possui
4. O atributo region do elemento <importBase> s deve existir se esse for
filho de uma <regionBase>.
Referéncia: Nao possui
5. O valor do atributo region do elemento <importBase> deve ser um id
de um elemento <region> do documento que fez a importagao.

Referéncia: p.56§ ult.
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6.

10.

11.

12.

Os documentos referenciados pelo atributo documentURI dos elementos

<importBase> e <importNCL> devem ser validados se existem.

Referéncia: Nao possui

. Um atributo refer nunca podera conter um id de outro elemento que

também possui um refer. Em outras palavras, refer de refer nao é

permitido.

Referéncia: p.57§ 6

Um elemento <media> e <switch> s6 poderao ter um atributo refer re-
ferenciando um id de um elemento <media> e <switch> respectivamente.
Os elementos referidos deverao estar definidos no <body> do documento

corrente ou em um <body> externo exportado.

Referéncia: p.57§ penult.

. Um elemento <context> e <body> s6 poderao ter um atributo refer

referenciando um id de um elemento <context> ou <body>. Os elementos
referidos deverao estar definidos no <body> do documento corrente ou em

um <body> externo exportado.

Referéncia: Guia de Operacoes p.4089

Quando um elemento define um atributo refer, todos os atributos sao
herdados do elemento referido. Quando o elemento que referencia define
atributos ou elementos filhos, estes sao ignorados, com excegao de: (1)
Atributo id; (2) Elementos <property> e <area> filhos de <media>; (3)

Atributo <instance> de <media>.

Referéncia: p.58§ 1

Se um novo elemento <property> adicionado tem o mesmo atributo
name de um elemento <property> ja existente (definido em um ele-
mento <media> reusado através do refer), o novo elemento <property>

adicionado deve ser ignorado.

Referéncia: p.58§ 2

Similarmente ao elemento <property>, se um novo elemento <area>
possui 0 mesmo atributo id de um elemento <area> ja existente (definida
em um elemento <media> reusado), o novo elemento <area> devera ser

ignorado.

Referéncia: p.58§ 2
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H.11
Modulo Navigation Key Functionality

1. O valor do atributo focusIndex deve ser tinico em todo o documento.
Referéncia: p.59§ 1
Estado: Faltando testes
2. Os valores dos atributos moveRight, moveLeft, moveDown, moveTop
devem ser um focusIndex valido.
Referéncia: p.59§ 2,3
3. O valor do atributo focusSrc e focusSelSrc do elemento <descriptor>

deve ser validado, verificando se o arquivo existe, similar ao atributo src

do elemento <media>.

Referéncia: p.59§ 5

4. Os atributos focusBorderColor, focusBorderWidth e focusBorderTransparency

do elemento <descriptor> devem estar de acordo com a norma (vide

referéncia).

Referéncia: p.59§ 6

5. Quando um elemento <media> faz referencia a outro elemento <media>
(usando o atributo refer), o atributo focusIndex especificado no ele-
mento <descriptor> associado com o elemento <media> referida sera

ignorado.

Referéncia: Guia de Operacoes p.42§2

H.12
Mdédulo Animation Key Functionality

Neste modulo, nenhum problema de codigo foi encontrado que nao pudesse

ser detectado a partir de uma validacao baseada no XML Schema.
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